Administration Guide
for Cisco Unified Contact Center Enterprise & Hosted
Release 8.0(1)

January 2012
# Table of Contents

Preface ......................................................................................................................................................1  
Purpose ..................................................................................................................................................1  
Audience ................................................................................................................................................2  
Organization ..........................................................................................................................................2  
Related Documentation .........................................................................................................................2  
Product Naming Conventions ............................................................................................................2  
Conventions ...........................................................................................................................................3  
Obtaining Documentation and Submitting a Service Request ...............................................................4  
Documentation Feedback .....................................................................................................................5  

## Part 1. Managing Cisco Unified Contact Center Enterprise Agents and Call Routing .............7  
1. Cisco Unified Contact Center Enterprise Agents ............................................................................9  
   About Administering Cisco Unified Contact Center Enterprise Agents ........................................9  
      What is a Cisco Unified Contact Center Enterprise Agent? ...........................................................9  
      Cisco Unified Intelligent Contact Management Database Records for Cisco Unified Contact Center  
         Enterprise Voice-Only Agents ......................................................................................................10  
      Database Records for Cisco Unified Contact Center Enterprise Multichannel Agents ................11  
      About Agent Desk Settings ..............................................................................................................11  
      About Agent Teams and Supervisors ..............................................................................................11  
      About Agent Teams and Multichannel Applications .......................................................................12  
      About the Cisco Unified Contact Center Enterprise Agent Re-skilling Tool ...............................13  
      Modifying the Skill Groups Per Agent Limit ....................................................................................13  
      Using the ConfigLimit Tool .............................................................................................................13  
      Additional Requirements ..................................................................................................................14  
      About Network Transfer for IVRs ...................................................................................................15  
      About Cisco Unified Contact Center Enterprise Routing ............................................................15  
      About Routing Operation ................................................................................................................15  
      About Routing Configuration ..........................................................................................................17  
      About Routing Scripts .....................................................................................................................20  
      Single-line Versus Multi-line Behavior ...........................................................................................20  

2. Configuring CTI OS and CAD Desktop Features ...........................................................................23  
   About Configuring Agent Features with Agent Desk Settings List Tool .......................................23  
      Agent Wrap-up ..............................................................................................................................23  
      Reason Codes ...............................................................................................................................24  
      Agent Desk Settings That Affect Reason Codes ..........................................................................24  
      Predefined Reason Codes ..............................................................................................................25  
      Redirection on No Answer ..............................................................................................................27  
      Emergency and Supervisor Assist Calls .......................................................................................28  
      About Configuring Supervisor Features .......................................................................................28  
      Barge-in .........................................................................................................................................28  
      Intercept .......................................................................................................................................29  

3. Routing Tasks for Multichannel Options .........................................................................................31  
   Configuring Cisco Unified Intelligent Contact Management/Contact Center Enterprise Software for  
      Multichannel Routing ......................................................................................................................31  
   Configuring Multichannel Software ................................................................................................32  

## Part 2. Performing Administrative Tasks with Cisco Unified Contact Center Enterprise ..........33
Index .............................................................................................................................................................61
List of Figures

Figure 1: Dialed Number Plan Entry Specifying Unified ICM Routing for the Agent Call............................................55
Preface

Purpose

This guide describes how to administer components of the Cisco Unified Contact Center Enterprise / Cisco Unified Contact Center Hosted (Unified CCE/CCH) solution. It includes information about administering Unified CCE for voice and multichannel contact centers.

Note: The information in this guide does not pertain to specifics of Cisco Unified System Contact Center Enterprise (Unified SCCE) deployments. The Cisco IPCC Enterprise Web Administration Tool is used for administering Unified SCCE. (Unified SCCE Release 7.5 is supported in the 8.0(1) solution.)

Access to the IPCC Web Administration Tool is limited to individuals with Contact Center administrator privileges.

To access the IPCC Enterprise Web Administration Tool:

1. In your browser's address bar, enter: https://<Administration & WebView Reporting machine DNS or IP address>/ipccAdmin.

2. Press Enter.

   The Login page displays.

   Note: The first time you access the IPCC Web Administration Tool you may be prompted to accept a security certificate.

3. Enter your IPCC administrator username and password.

   Passwords are case-sensitive.
Note:

- Log in with your Active Directory username and password.
- Refer to the Cisco IPCC Enterprise Web Administration Tool online help for detailed information about using this tool.

Audience

This document is intended for contact center supervisors and administrators.

Organization

The following table describes the information contained in each section of this guide:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part I: Managing Cisco Unified Contact Center Enterprise Agents and Call Routing (page 7)</td>
<td>Provides conceptual information about Unified CCE agents, agent features, and call routing.</td>
</tr>
<tr>
<td>Part II: Performing Administrative Tasks with Cisco Unified Contact Center Enterprise (page 33)</td>
<td>Describes how to perform administrative tasks using Unified CCE with Cisco Unified Intelligent Contact Management (Unified ICM) software (documented as &quot;system software&quot; in this guide).</td>
</tr>
</tbody>
</table>

Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at: [http://www.cisco.com/cisco/web/psa/default.html](http://www.cisco.com/cisco/web/psa/default.html).

Related documentation includes the documentation sets for Cisco CTI Object Server (CTI OS), Cisco Agent Desktop (CAD), Cisco Agent Desktop Browser Edition (CAD-BE), Cisco Unified Contact Center Management Portal, Cisco Unified Customer Voice Portal (CVP), Cisco Unified IP IVR, Cisco Unified Intelligence Center, and Cisco Support Tools. The following list provides more information.

- For documentation for the Cisco Unified Contact Center products mentioned above, go to [http://www.cisco.com/cisco/web/psa/default.html](http://www.cisco.com/cisco/web/psa/default.html), click Voice and Unified Communications, then click Customer Collaboration, and then click Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click the product or option you are interested in.

- For troubleshooting tips for the Cisco Unified Contact Center Products mentioned above, go to [http://docwiki.cisco.com/wiki/Category:Troubleshooting](http://docwiki.cisco.com/wiki/Category:Troubleshooting), and then click the product or option you are interested in.
Product Naming Conventions

In this release, the product names listed in the table below have changed. The New Name (long version) is reserved for the first instance of that product name and in all headings. The New Name (short version) is used for subsequent instances of the product name.

**Note:** This document uses the naming conventions provided in each GUI, which means that in some cases the old product name is in use.

<table>
<thead>
<tr>
<th>Old Product Name</th>
<th>New Name (long version)</th>
<th>New Name (short version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IPCC Enterprise Edition</td>
<td>Cisco Unified Contact Center Enterprise</td>
<td>Unified CCE</td>
</tr>
<tr>
<td>Cisco System IPCC Enterprise Edition</td>
<td>Cisco Unified System Contact Center Enterprise</td>
<td>Unified SCCE</td>
</tr>
<tr>
<td>Cisco IPCC Hosted Edition</td>
<td>Cisco Unified Contact Center Hosted</td>
<td>Unified CCH</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Enterprise Edition</td>
<td>Cisco Unified Intelligent Contact Management Enterprise</td>
<td>Unified ICME</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Hosted Edition</td>
<td>Cisco Unified Intelligent Contact Management Hosted</td>
<td>Unified ICMH</td>
</tr>
<tr>
<td>Cisco CallManager/Cisco Unified CallManager</td>
<td>Cisco Unified Communications Manager</td>
<td>Unified CM</td>
</tr>
</tbody>
</table>

Conventions

This manual uses the following conventions:
<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong> font</td>
<td>Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Edit &gt; Find</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td><strong>italic</strong> font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term; for example: A <strong>skill group</strong> is a collection of agents who share similar skills</td>
</tr>
<tr>
<td></td>
<td>• For emphasis; for example: <strong>Do not</strong> use the numerical naming convention</td>
</tr>
<tr>
<td></td>
<td>• A syntax value that the user must replace; for example: <strong>IF</strong> <em>(condition, true-value, false-value)</em></td>
</tr>
<tr>
<td></td>
<td>• A book title; for example: Refer to the <strong>Cisco CRS Installation Guide</strong></td>
</tr>
<tr>
<td><strong>window</strong> font</td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td></td>
<td>• Text as it appears in code or that the window displays; for example: <strong>&lt;html&gt;&lt;title&gt;Cisco Systems, Inc.&lt;/title&gt;&lt;/html&gt;</strong></td>
</tr>
<tr>
<td></td>
<td>• Navigational text when selecting menu options; for example: <strong>ICM Configuration Manager &gt; Tools &gt; Explorer Tools &gt; Agent Explorer</strong></td>
</tr>
<tr>
<td><strong>&lt; &gt;</strong></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• For arguments where the context does not allow italic, such as ASCII output</td>
</tr>
<tr>
<td></td>
<td>• A character string that the user enters but that does not appear on the window such as a password</td>
</tr>
</tbody>
</table>

**Obtaining Documentation and Submitting a Service Request**

For information about obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What’s New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:

Subscribe to *What's New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

**Documentation Feedback**

You can provide comments about this document by sending an email message to the following address:

[ccbu_docfeedback@cisco.com](mailto:ccbu_docfeedback@cisco.com)

We appreciate your comments.
Part 1: Managing Cisco Unified Contact Center Enterprise Agents and Call Routing

The following sections provide conceptual information about Unified CCE agents, agent features, and call routing.
Cisco Unified Contact Center Enterprise Agents

This chapter explains the concepts you must be familiar with when setting up agents for your Unified CCE contact center.

This chapter contains the following topics:

- About Administering Cisco Unified Contact Center Enterprise Agents, page 9
- About the Cisco Unified Contact Center Enterprise Agent Re-skilling Tool, page 13
- Modifying the Skill Groups Per Agent Limit, page 13
- About Network Transfer for IVRs, page 15
- About Cisco Unified Contact Center Enterprise Routing, page 15
- Single-line Versus Multi-line Behavior, page 20

About Administering Cisco Unified Contact Center Enterprise Agents

This section provides information about the Cisco Unified Contact Center Enterprise agent, including associating the agent with database records and agent desk settings.

What is a Cisco Unified Contact Center Enterprise Agent?

An agent is an individual who handles customer contact within your contact center. In a Unified CCE configuration, you can create two types of agents:

<table>
<thead>
<tr>
<th>Agent type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice-only agents</td>
<td>Agents able to receive telephone calls. You can also configure Voice-only agents to receive non-voice requests such as chat, blended collaboration, and email.</td>
</tr>
<tr>
<td>Multichannel agents</td>
<td>Agents able to receive voice calls and requests from other media. You can also configure multichannel agents to only</td>
</tr>
</tbody>
</table>
Agent type | Description
--- | ---
 | receive non-voice requests such as chat, blended collaboration, and email.

**Note:** You must have Cisco’s multichannel software installed as part of your Unified CCE configuration to create multichannel agents.

**Note:** In most cases, the Cisco Unified Communications Manager (Unified CM) peripheral on the Generic IPCC peripheral gateway (PG), which is set up with your initial Unified CCE installation, tracks and records the state and activity of all voice and non-voice agents. You can configure a non-voice PG rather than a Unified CM PG to monitor state and activity of agents configured as non-voice agents. However, this is optional, and is not necessary if you already have a Unified CM peripheral on the Generic IPCC PG. When using Unified SCCE, agent tracking is performed using the Agent/IVR Controller.

**Cisco Unified Intelligent Contact Management Database Records for Cisco Unified Contact Center Enterprise Voice-Only Agents**

In the Unified ICM database, each agent must be associated with two database records:

<table>
<thead>
<tr>
<th>Unified ICM Database Record</th>
<th>Description</th>
</tr>
</thead>
</table>
| Person record | Identifies the individual. Person records must exist for all Unified CCE agents. Every agent in your configuration must have a single Person record. This record can then be associated with one or multiple Agent records, as described below.  
**Note:** Unified SCCE automatically sets the Person record. In Unified SCCE, there is a one-to-one correspondence between the agent and the person. |
| Agent record | Identifies the agent working on a particular peripheral. There must be a one-to-one correspondence between each Agent record and its associated peripheral. However, in Unified CCE, if an agent is going to be working on several peripherals, you can create several Agent records and associate these with the same Person record. In this way, a single agent can work on several different peripherals. In Unified SCCE, this only works if done from the parent system. |

When you create an Agent record, you have the option of associating it with an existing Person record (select **Select Person**). If you do not associate the Agent record with an existing Person record, a new Person record is automatically created when you create the agent.
Database Records for Cisco Unified Contact Center Enterprise Multichannel Agents

Unified CCE agents who will use multichannel software are associated with three different database records:

- The Person record in the Unified ICM/CCE database
- The Agent record in the Unified ICM/CCE database
- The Agent record in the database for the multichannel application

About Agent Desk Settings

Each Agent record must be associated with an Agent Desk Setting. The Agent Desk Settings configuration is used to associate a set of permissions or characteristics with specific agents. These settings are comparable to Class of Service settings on a PBX or ACD. Desk settings are associated with an agent when the agent is configured in the Unified ICM database. The desk settings are global in scope and they can be applied to any configured agent on any peripheral within a Unified ICM/CCE configuration.

If desktop settings are not associated with a configured agent, the agent is assigned the peripheral default settings. The peripheral default settings depend on the default setting for the Generic IPCC PG the agent is logged in to.

**Note:** See the "About Configuring Agent Features with Agent Desk Settings List Tool (page 23)" section for detailed information.

About Agent Teams and Supervisors

You can organize Unified CCE voice agents into teams. A team is a collection of agents grouped for reporting purposes.

**Note:** A single agent can only belong to one team.

Unified ICM/CCE software allows you to group individual agents into agent teams that can be managed by supervisors. Agent teams are assigned to a specific peripheral, so all agents of a given team must also be assigned to the same Unified CM peripheral.

Unified ICM/CCE software lets you assign both Primary and Secondary supervisors to an individual team. It is recommended that you set up your teams with both a Primary and a Secondary supervisor. This setup helps to accommodate Supervisor and Emergency assist scenarios.

Supervisors listed on the Agents team list are able to view real-time statistics (using your reporting application). Supervisors can, for example, barge-in, intercept, silently monitor, and log out agents in the associated team using the CTI Toolkit IPCC Supervisor Desktop application.
Note: If you use Cisco Agent Desktop (CAD), you must configure the supervisor in Unified ICM/CCE software first, then configure the supervisory features within CAD.

For reporting purposes, you can report on agent teams and agents grouped into teams. Also, supervisors can run reports on their teams. (Refer to the Reporting Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted for detailed information about reporting.)

Each team you set up must have an agent supervisor associated with it. You can then configure supervisory agent features, to allow the supervisor to better monitor agent activity and assist agents on their team. When you create an agent supervisor, you must enter the following information for the supervisor:

- Windows Domain name to which the agent team belongs
- Windows User ID for the supervisor
- Windows password for the supervisor

When configuring agent teams, be aware of the following rules:

- An agent can be a member of only one agent team.
- An agent team can have only one Primary Supervisor
- A supervisor can be a supervisor of any number of agent teams.
- A supervisor for an agent team can also be a member of that agent team.
- All agents belonging to an agent team and all supervisors for that agent team must be on the same peripheral.
- A supervisor cannot be using the Windows administrator account when logging in as supervisor.

About Agent Teams and Multichannel Applications

You can group voice agents into teams using the Unified ICM/CCE/CCH Administration User Interface. Note, however, that there is no team feature in Cisco Unified E-Mail Interaction Manager (Unified EIM) and Cisco Unified Web Interaction Manager (Unified WIM); therefore, Unified EIM-only agents and Unified WIM-only agents cannot be grouped into teams.

See Also

For information about agent features, see the "Configuring CTI OS and CAD Desktop Features (page 23)" section.

For information about supervisory features, refer to the CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted and the CTI OS Supervisor Desktop User Guide for Cisco Unified Contact Center Enterprise & Hosted, and see the "About Configuring Supervisor Features (page 28)" section.
About the Cisco Unified Contact Center Enterprise Agent Re-skilling Tool

The Unified CCE Agent Re-skilling Tool is an optional, browser-based application designed for use by Unified CCE call center supervisors. It lets you change the skill group designations of agents on your team, and quickly view skill group members and details on individual agents. Changes made to an agent's skill group membership take place immediately without the need for the agent to exit and re-enter the system.

Note:
• If an agent is currently in a call, a change to the agent's skill group membership takes place after the call has terminated.

• The Agent Re-skilling Tool is an optional tool and must be installed for you to take advantage of these features.

Modifying the Skill Groups Per Agent Limit

Unified ICM and Unified CCE impose a default limit on the number of skill groups that you can assign to a single agent. Once this limit is reached, additional skill groups cannot be assigned. The default limit is specified in the *Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND)*. The limit considers the total of both skill groups and sub-skill groups.

If desired, you can use the ConfigLimit Tool to specify your own limit on the number of skill groups that can be assigned to an agent. For optimum performance, you can specify a limit far lower than the system default (refer to the *Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND)* for performance considerations in choosing a skill groups per agent limit).

Warning: Setting a default value for skill groups per agent that is higher than the system default can adversely affect system performance. Cisco will not support configurations that exceed the default value.

Caution: The ConfigLimit tool is a command-line tool utility from the bin directory of all Unified ICM/CCE Administration & Data Servers. Access is limited to users with privileges for the Setup or Config Groups in Active Directory for the chosen customer instance. (Refer to the *Outbound Option Guide for Cisco Unified Contact Center Enterprise & Hosted* for detailed information about the ConfigLimit tool.)

Using the ConfigLimit Tool

To change the skill groups per agent limit in configlimit.exe:

**Step 1** Launch a command line window on any Administration Client or Administration & Data Server.
Modifying the Skill Groups Per Agent Limit

**Step 2** Enter `configlimit`.

**Step 3** Optionally, enter `cl /show` to view the existing limit.

**Step 4** To change the limit, enter `cl /id 1 value/<new_value> /update`

For example, to change the skill groups per agent limit to 5, enter the following text: `cl /id 1 value/5 /update`

**Step 5** Press Enter.

---

### Additional Requirements

#### Lowering the Limit

If you have modified the skill groups per agent limit to be lower than the system default, no additional changes are necessary. The new, lower limit will be enforced immediately. Note that the new limit will **not** impact agents whose existing skill group membership exceeds the new limit until the next attempt to add a new skill group for those agents. At that time the new limit will be enforced, preventing you from adding additional skill groups.

#### Exceeding the Default Limit

If you have modified the skill groups per agent limit to be higher than the system default (in spite of the Warning given above), certain deployments will require additional changes (listed in the following sections) to your system to use the new limit and will allow you to add additional skill groups.

**Note:** If you exceed the default limit and are using CTI OS, do **not** exceed a maximum of 99 skill groups.

#### IPCC Gateway PG

For IPCC Gateway deployments, modify the following registry keys on your IPCC Gateway PGs to include the new value. A change to the registry will require that the PG service be restarted.

**IPCC Enterprise Gateway PIM** (Cisco Unified Contact Center Enterprise parent)

```
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM< customer_instance >\PG{[A|B]}\PG\CurrentVersion\PIMS\pim{m}\ACMIData\Config\MaxSkills
```

**IPCC Express Gateway PIM** (Cisco Unified Contact Center Express parent)

```
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM< customer_instance >\PG{[A|B]}\PG\CurrentVersion\PIMS\pim{n}\ACMIData\Config\MaxSkills
```
ERI PG

For ERI deployments, modify the following registry key on your ERI PGs to include the new value. A change to the registry will require that the PG service be restarted.

```
ERI Service PIM

HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\< customer_instance >\PG{n}\[A|B]\PG\CurrentVersion\PIMS\pim(n)\ERSData\Config\MaxSkills
```

About Network Transfer for IVRs

When a call is transferred from an IVR (for example, IP IVR) to an agent and that agent wants to transfer the call to another agent, the transfer can be made either from the agent's IP phone or the agent desktop.

Transfers made from the:

• IP phone are made using CTI route points that point to a Unified ICM/CCE script.

• Agent desktop are made using the Dialed Number Plan.

**Note:** If the route point is configured using Unified CM, there is no difference between using the hard phone or the desktop phone.

For network transfer from either the IP phone or the CTI Toolkit Agent Desktop, you must queue the call to the skill group in the first Unified ICM/CCE script; for example, "NetXfer1," to create the call context. In this script, the "networkTransferEnabled" flag must be set to "1."

**Note:** IP IVR does not support network transfer. Unified CVP only supports network "blind" transfer.

About Cisco Unified Contact Center Enterprise Routing

To understand how Unified CCE routes voice calls, you must understand the concepts of routing operation and routing configuration.

About Routing Operation

To understand how Unified CCE routing occurs, you must understand these concepts:

• **The Routing Client:** The Unified CCE component that submits a route request to the Central Controller.

In Unified CCE configurations, the routing client can be:
– The Unified CM PG or Unified SCCE Agent/IVR Controller
– An interexchange carrier (IXC)
– A VRU PG
– A Media Routing Peripheral Gateway

Essentially, when a routing client makes a request for a route from the Unified ICM/CCE platform, it receives the response and delivers the call to the specified destination. If an Unified CCE agent is available, Unified ICM/CCE software routes the call to the device target (phone) on the Unified CM (device targets are dynamically associated with the agent when the agent logs in to the system). If an agent is not available, Unified ICM/CCE software can be configured to queue the call to IP IVR or Unified CVP.

• **Route and Queuing Requests:** Messages sent from the routing client to the Central Controller. Route requests typically pass along call detail information about the incoming call. Unified ICM/CCE software uses information in the route request to determine which routing script will be run for the call.

  Call detail information sent with the route request can include:

  – Dialed Number (DN)
  – Calling line ID (CLID)
  – Caller Entered Digits (CED)

Queueing requests are messages sent from the VRU using the Cisco Service Control Interface. The VRU makes a queue request to provide announcements or music when no Unified CCE agents are available to take the call.

• **About Routing to the VRU with Unified CCE:** With Unified CCE you can ensure that voice calls are routed to the VRU when an agent is not immediately available. The call is queued to the VRU and sent to the next available agent via the routing script.

  The configurations for routing to a VRU in a Unified CCE environment include:

  – Translation Route to the VRU via a route on the PG. The Unified CM uses the DNIS in the translation route to direct the call to the VRU.

  – A network route request is issued by the carrier via the NIC. The DNIS and/or Correlation ID is retrieved from the carrier.

  – The call is sent directly to the VRU, so that caller entered digits (CED) can be collected.

You do not need a translation route to a Unified CM PG since it is targeting agents and implicitly matches call data.
• **Routing a Call to the VRU:** Translation routing is the preferred method of routing a call to the VRU. The DNIS used in the translation route is not the original number dialed by the customer, but rather, the Dialed Number used to route the call to the VRU.

The scenario is as follows:

.a Call comes in to the Unified CM.

.b Unified CM identifies the number as a route point for the Unified CM PG.

.c The Unified CM PG receives a route request from the Unified CM and forwards it to the CallRouter.

.d The CallRouter runs the script for the translation route to the VRU.

.e A Label is returned to the Unified CM via the Unified CM PG.

.f The Unified CM routes the call to the VRU, based on the CTI route point for the translation route.

.g VRU sends up a request instruction with the DN as the DNIS.

.h VRU PG matches up the call and the Correlation ID, then informs the CallRouter of the call arrival with a "request instruction."

.i The CallRouter matches the correlation ID and finds the pending script/call.

.j The CallRouter continues with script (for example, run script).

For translation routing, the VRU Type to configure in the Network VRU in the Unified ICM/CCE/CCH Administration User Interface is type 2.

Be sure the Unified CM PG routing client and the VRU PG routing client both have the labels mapped for the peripheral targets in the translation route.

---

**About Routing Configuration**

To set up routing in your Unified CCE system, you must set up the following entities:

• **Dialed Numbers:** The dialed number is the number that the caller dials to contact an agent. It is sent as part of the call detail information in the route request message sent from the routing client.

In the system software, you set up a Dialed Number List. It identifies all of the phone numbers in your contact center that customers can dial to initiate contact.

**Note:** Unified SCCE does not support Dialed Number Lists. Instead, it only uses dialed numbers.
The Dialed Number plays an integral role in routing calls. Dialed Numbers are required pieces of Unified ICM call types that are used to identify the appropriate routing script for each call.

- **Call Types:** A call type is a category of incoming Unified ICM routable tasks. Each call type has a schedule that determines which routing script or scripts are active for that call type at any time. There are two classes of call types: voice (phone calls) and non-voice (for example, email and text chat). Voice call types are categorized by the dialed number (DN), the caller-entered digits (CED) and the calling line ID (CLID). Non voice call types are categorized by the Script Type Selector, Application String 1, and Application String 2. In either case, the last two categories of the call type can be optional. For voice call types, the caller-entered digits and the calling line ID can be optional, depending on the call. For non voice call types, Application String 1 and Application String 2 can be optional, depending on the application.

Because the call type determines which routing script is run for a call, the call type defines call treatment in a Unified CCE system. Therefore, the call type is the highest level reporting entity. Reporting on call type activity provides insight into end-to-end customer interactions with the system and with agents by providing data such as service level adherence, transfers, average speed of answer, calls handled, and calls abandoned.

In routing scripts, such as scripts for Self-Service VRU applications, you may change the call type at specific points in the script to indicate that a transaction has been completed. For example, if the customer is calling a bank and successfully checks his or her account balance using a Self-Service script, you may want to change the call type to indicate that the account balance transaction has completed and a new transaction has begun.

You can also change the call type in a script to invoke a new routing script associated with that call type. For example, if a call is not answered at an agent's desktop, you can change the call type in the script to redirect the call to a different script designed for Redirection on No Answer. The Redirection on No Answer script assigns a different agent to handle the call.

- **Routes:** Unified ICM/CCE software uses routes to define the mapping of a target to a specific label for a routing script. Targets include services (service targets), skill groups (skill targets), agents (device targets), and translation routes.

Routes must be defined for VRU Translation Routing and to route calls to agents.

- **Device Targets:** A device target is a telephony device that can be uniquely addressed (or identified) by a telephone number. A device target is not associated with any one peripheral. Each device target must have one or more labels associated with it, although only one label may exist per routing client.

You do not need to use device targets when configuring Unified CCE using the IPCC Enterprise Web Administration Tool. If you are not using the IPCC Enterprise Web Administration Tool and you are configuring a Unified SCCE PG, you must use device targets.

**Note:** Device targets and agents are separate entities. A device target is a separately addressable device and is not exclusively owned by any particular agent. Device targets are dynamically associated with Unified CM PG agents for the duration of a log in session.
Each Unified CM PG telephony device that is used by an agent must be configured in the Unified ICM database as a device target.

- **Labels**: A label is the value that Unified ICM/CCE software returns to a routing client instructing it where to send the call. The routing client can map the label to an announcement, a trunk group and DNIS, or a device target. Special labels might instruct the routing client to take another action, such as playing a busy signal or an unanswered ring to the caller.

  If the label is for a device target, the routing client is responsible for delivering the call to the device target on the Unified CM through the voice gateway.

  If the label is for a VRU queue point, the routing client delivers the call to the Route Point on the VRU. The VRU must recognize that the call has arrived and then request queue instructions from Unified ICM/CCE software. Unified ICM/CCE software returns either a destination for the call or instructions on what script the VRU will run, based on a particular Call Type.

  **Note**: Labels are not used with Unified SCCE.

- **Services**: You set up Services in Unified ICM/CCE software to represent the type of processing that a caller requires, and to configure VRU Services to route calls to the VRU. For example, separate services might be defined for Sales, Support, or Accounts Payable. A Service is often associated with a peripheral and can be referred to as a Peripheral Service.

  For Services that are used to route a call to an agent, they must be associated with skill groups. You associate different Skill Groups with Services by making them members of the Service. Using Services allows you to group agents working in like skill groups.

  **Note**: Services are not used with Unified SCCE.

- **Skill Groups**: Agents must be associated with skill groups to receive Unified ICM-routed calls. You create skill groups using the Unified ICM/CCE/CCH Administration User Interface.

  You can only configure one type of skill group: *base skill groups*.

  A *base skill group* is the main skill group created using the Unified ICM/CCE/CCH Administration User Interface. Using base skill groups ensures accurate agent reporting and simplifies configuration and scripting for your contact center.

  A *sub-skill group* is a subdivision of a base skill group. Sub-skill groups are only supported for Avaya PG, Symposium PG, Spectrum PG, and NEC PG TDM peripherals.

  **Note**: You can *not* create a sub-skill group for the System PG, CallManager, and ARS PG peripheral types. The only operation allowed on these sub-skill groups on these peripheral types is their removal. Once the sub-skill groups are removed, they *cannot* be added back into the configuration. However, if a sub-skill group already exists from a Unified CCE release prior to upgrading, the sub-skill group is still supported after upgrading. Sub-skill groups are also *not* supported for non-voice skill groups. That is, you cannot create sub-skill groups for these media classes: chat, blended collaboration, and email.

- **Migrating from Sub-skill Groups to Base or Enterprise Skill Groups:**
Follow these steps to migrate from sub-skill groups to base and enterprise skill groups.

– Disable the sub-skill group mask for the peripheral using the PG Explorer tool. All skill groups created after this is done are base skill groups.

– Define a new base skill group to correspond with each sub-skill group being removed.

– Assign agents to the new base skill groups and remove them from your sub-skill groups.

– Optionally, create enterprise skill groups to group the base skill groups (in order to simplify the migration path).

– Update all of your routing scripts and reporting templates so that they refer to the newly created base or enterprise skill groups.

About Routing Scripts

A routing script (created using the Script Editor) identifies the desired agent (based on skills and customer database profile), determines the call target, and returns a route response to the routing client.

Single-line Versus Multi-line Behavior

The following table details single-line behavior versus multi-line behavior.

<table>
<thead>
<tr>
<th>Action</th>
<th>Single-line Behavior</th>
<th>Multi-line Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a routed call while call is on second line?</td>
<td>Yes</td>
<td>Yes, when Non ACD Line Impact is set no impact for the deployment.</td>
</tr>
<tr>
<td>Supervisor monitor second line using Supervisor Desktop Monitor (CTI OS or CAD)?</td>
<td>Yes, but supervisor will not know agent had calls by looking at desktop</td>
<td>Yes, and supervisor will see second line calls on desktop by default.</td>
</tr>
<tr>
<td>Supervisor Monitor using Unified CM-based silent monitor</td>
<td>No</td>
<td>Yes, depending on the CTI OS Server privacy configuration.</td>
</tr>
<tr>
<td>Call park</td>
<td>Supported on unmonitored second line</td>
<td>Not supported since all lines are monitored</td>
</tr>
<tr>
<td>Join Across Lines (JAL)/Direct Transfer across Lines (DTAL)</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Shared line</td>
<td>Supported on unmonitored line; no configuration limitations</td>
<td>Not supported when Agent Phone Line Control is enabled for the deployment.</td>
</tr>
<tr>
<td>Call Waiting / Busy trigger &gt; 1</td>
<td>No longer supported</td>
<td>No longer supported. Hard-coded to 1 on 69xx series phones (must be configured before enabling multi-line).</td>
</tr>
</tbody>
</table>
### Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Single-line Behavior</th>
<th>Multi-line Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting on second line calls</td>
<td>Use CDRs in Unified CM.</td>
<td>Termination Call Detail records for call to or from an agent's Non ACD line with an unmonitored device or another agent's Non ACD line will be reported with a Non ACD Peripheral Call Type. Reporting for all calls on the Non ACD line will be captured in the Agent Interval table for that agent.</td>
</tr>
<tr>
<td>Number of configured lines on phone</td>
<td>No limit described (only monitoring one line)</td>
<td>Maximum of four lines. Agent login will be rejected. Config Alert generated.</td>
</tr>
</tbody>
</table>

### See Also

Refer to the *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted* for detailed information about enabling the Cisco Round Table phones. Refer to the *Installation Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted* and the Cisco Unified Communications Manager documentation for detailed information about configuring the Cisco Round Table phones.
Chapter 1: Cisco Unified Contact Center Enterprise Agents

Single-line Versus Multi-line Behavior
Chapter 2

Configuring CTI OS and CAD Desktop Features

This chapter contains the following topics:

- About Configuring Agent Features with Agent Desk Settings List Tool, page 23
- About Configuring Supervisor Features, page 28

About Configuring Agent Features with Agent Desk Settings List Tool

Each voice Agent record must be associated with an Agent Desk Setting (not necessary for non-voice agents). The Agent Desk Settings List tool configuration is used to associate a set of permissions or characteristics with specific agents. You can use the Agent Desk Settings List tool to configure the following agent features:

- Agent Wrap-up
- Reason Codes
- Redirection on No Answer
- Emergency and Supervisor Assist Calls

Agent Wrap-up

Agents can enter Wrap-up mode after completing a call. Wrap-up mode enables the agent to finish with any tasks that require after-call work before entering a Ready state. When in Wrap-up mode, the agent is not routed any additional tasks.

Agents can manually enter Wrap-up state by activating the wrap-up button on their soft phone. You can also configure Agent Desk Settings so that agents automatically enter Wrap-up mode after finishing each call.
When you create Agent Desk Settings using the Unified ICM/CCE/CCH Administration User Interface, you can specify whether agents enter Wrap-up mode automatically after finishing incoming calls. The Work Mode Settings allow you to specify whether the agent must enter Wrap-up mode after incoming calls. You can also use these settings to require agents to enter reason codes while in Wrap-up mode (incoming calls only).

Reason Codes

Agents select reason codes when they:

- Log out of the agent desktop system
- Enter Wrap-up mode after a call
- Change to a Not Ready state

Reason codes allow you to track the agent's state and logout status as it changes. You configure reason codes using the agent desktop application (CTI OS and/or the CAD administrator's desktop). If you use the CTI OS desktop, you can also configure Unified ICM/CCE software to control when reason codes are required.

Agent Desk Settings That Affect Reason Codes

<table>
<thead>
<tr>
<th>Agent Desk Setting Option</th>
<th>Affects this type of reason code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work mode on Incoming</td>
<td>Wrap-up</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Not Ready</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Logout</td>
</tr>
</tbody>
</table>

Wrap-Up Reason Codes and Work Mode

If you use the CTI Toolkit Agent Desktop, you can use the Work Mode on Incoming option on the Agent Desk Settings List window to specify when and if agents are required to enter reason codes when entering wrap-up for incoming calls. The following table describes Work Mode on Incoming options and explains how reason codes are related to each:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Ensures that the agent automatically enters Wrap-up state after completing the call.</td>
<td>The agent can choose to enter a reason code.</td>
</tr>
<tr>
<td>Optional</td>
<td>Allows agents to choose whether to activate the wrap-up button or the Not Ready button to end the call.</td>
<td>If the agent uses the wrap-up button, the agent can choose to enter a reason code.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Restricts the agent from entering Wrap-up mode. The Agent can go into Not Ready mode.</td>
<td>The agent can decide whether to enter a Not Ready reason code.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Ensures that the agent automatically enters Wrap-up state after completing the call.</td>
<td>The agent must enter a reason code.</td>
</tr>
</tbody>
</table>
The following table describes the CAD configuration for Work Mode on Incoming options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Optional</td>
<td>Recommended setting when using CAD.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Configure Wrap-up options in Cisco Desktop Administrator.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Not used with CAD.</td>
</tr>
</tbody>
</table>

The following table describes the CAD configuration for Work Mode on Outgoing options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>When the agent drops an outbound call, the agent goes into a Work Not Ready state for the time specified in the Wrap-up time in the agent desk settings and pops the Wrap-up options, if they are enabled in the CAD Desktop Administrator application.</td>
</tr>
<tr>
<td>Optional</td>
<td>Recommended setting if not using Wrap-up options for outbound calls.</td>
</tr>
<tr>
<td>Not Allowed</td>
<td>Not used with CAD.</td>
</tr>
<tr>
<td>Required with wrap-up data</td>
<td>Not used with CAD.</td>
</tr>
</tbody>
</table>

**Predefined Reason Codes**

Unified CCE uses several predefined reason codes to indicate certain system events, described in the following table:

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>Agent state changed because the agent did not answer the call.</td>
</tr>
<tr>
<td>50001</td>
<td>The CTI OS client disconnected, logging the agent out.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This reason code is converted to a 50002, so 50001 does not display in the agent log out records.</td>
</tr>
<tr>
<td>50002</td>
<td>A CTI OS component disconnected, causing the agent to be logged out or set to the Not Ready state. This could be due to closing the agent desktop application, heart beat time out, or a CTI OS Server failure.</td>
</tr>
</tbody>
</table>
### About Configuring Agent Features with Agent Desk Settings List Tool

#### Reason Code vs. Description

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>50003</td>
<td>Agent was logged out because the Unified CM reported the device out of service.</td>
</tr>
<tr>
<td>50004</td>
<td>Agent was logged out due to agent inactivity as configured in agent desk settings.</td>
</tr>
<tr>
<td>50005</td>
<td>For a Unified CCE agent deployment, where the Agent Phone Line Control is enabled in the peripheral and the Non ACD Line Impact is configured to impact agent state, the agent will be set to Not Ready while talking on a call on the Non ACD line with this reason code.</td>
</tr>
<tr>
<td>50010</td>
<td>Agent was set to Not Ready state because the agent was routed two consecutive calls that did not arrive.</td>
</tr>
<tr>
<td>50020</td>
<td>Agent was logged out when the agent's skill group dynamically changed on the Administration &amp; Data Server.</td>
</tr>
<tr>
<td>50030</td>
<td>If an agent is logged in to a dynamic device target that is using the same dialed number (DN) as the PG static device target, the agent is logged out.</td>
</tr>
<tr>
<td>50040</td>
<td>Mobile agent was logged out because the call failed.</td>
</tr>
<tr>
<td>50041</td>
<td>Mobile agent state changed to Not Ready because the call fails when the mobile agent's phone line rings busy.</td>
</tr>
<tr>
<td>50042</td>
<td>Mobile agent was logged out because the phone line disconnected while using nailed connection mode.</td>
</tr>
<tr>
<td>-1</td>
<td>Agent reinitialized (used if peripheral restarts).</td>
</tr>
<tr>
<td>-2</td>
<td>PG reset the agent, normally due to a PG failure.</td>
</tr>
<tr>
<td>-3</td>
<td>An administrator modified the agent's extension while the agent was logged in.</td>
</tr>
</tbody>
</table>

These reason codes appear in these reports:

- Agent log out reports if the event caused the agent to log out
- Agent real time reports if the agent was set to a Not Ready state
- Agent Not Ready reports

**Note: Important!** For reporting on all PGs other than VRU PGS, be sure to select the **Agent event detail** check box on the Agent Distribution tab in the Unified ICM/CCE/CCH Administration User Interface's PG Explorer tool. This check box must be enabled to report on Not Ready reason codes.

If you are using Cisco Agent Desktop (CAD), the Desktop Administrator uses the following predefined reason codes:

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20001</td>
<td>Places the agent in the Not Ready state first before forcefully logging them off.</td>
</tr>
<tr>
<td>Reason Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>20002</td>
<td>Forces the logout request; for example, when Agent A attempts to log in to Cisco Agent Desktop and Agent B is already logged in under that agent ID, Agent A is asked whether or not to force the login. If Agent A answers yes, Agent B is logged out and Agent A is logged in. Reports would then show that Agent B logged out at a certain time with a reason code of 20002 (Agent B was forcibly logged out).</td>
</tr>
<tr>
<td>20003</td>
<td>If not already in the Logout state, request is made to place agent in the Not Ready state. Then logout request is made to log agent out.</td>
</tr>
<tr>
<td>Supervisor Not Ready</td>
<td>This code is reserved.</td>
</tr>
<tr>
<td>Supervisor Logout</td>
<td>This code is reserved.</td>
</tr>
</tbody>
</table>

**Note:** Cisco Unified Mobile Agent is the only exception, where CAD will not allow you to log out a login name/ID that is already in use.

### Redirection on No Answer

You can configure your Unified CCE system to handle and accurately report on situations when the agent does not answer his or her phone. These situations are referred to as Redirection on No Answer.

Although you can specify some values that control Redirection on No Answer situations, configuring Redirection on No Answer involves additional steps:

- Unified ICM/CCE configuration
- Unified ICM/CCE scripting
- Unified CM configuration

Redirection on No Answer conditions are handled by two routing scripts: the initial routing script and a script specifically set up for these conditions. The initial routing script handles the incoming call; when the call is redirected on no answer from the agent's IP phone, the script branches to another script set up specifically for Ring No Answer conditions.

**Note:** The Target Requery script feature, implemented using the Label, Queue, Route Select, and Select nodes, is not supported for Unified CCE systems; however, it is supported for Cisco Unified Customer Voice Portal (Unified CVP).

**See Also**

Emergency and Supervisor Assist Calls

Agents can activate supervisor assist or emergency assist buttons on their desktop when they need special assistance from the primary or secondary supervisor assigned to their team.

Agents can use the Supervisor and Emergency assist features, regardless of whether or not they are on a call.

There are two types of supervisor and emergency assist calls:

- Existing call - Consultative Conference
- No call

**Note:** Blind Conference is not supported for Emergency and Supervisor Assist.

About Configuring Supervisor Features

**Note:** If you use Cisco Agent Desktop (CAD), you must configure the supervisor in Unified ICM/CCE software first, then configure the supervisory features using Cisco Desktop Administrator.

The CTI Toolkit IPCC Supervisor Desktop includes functions that allow supervisors to monitor and manage their agent team members. A supervisor desktop application has all of the capabilities of an agent desktop application plus supervisor services to monitor and manage agent team members. The desktop application supports the Barge-In and Intercept call monitoring features.

**Note:** Refer to the Reporting Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted for information on setting up Unified CCE supervisory features. These instructions help ensure successful use of these features and accurate reporting. See the "How to Create an Agent Supervisor (page 35)" section for information about configuring supervisor features.

Barge-in

When using the CTI OS Desktop to barge in on an agent's call, a supervisor needs to select an agent from the Team State Information grid and select a call from the Monitored Calls section. The supervisor can select a call in this window and then select the **Barge-In** button. The supervisor then becomes party to the call. The supervisor must be in the Not Ready state to use the barge-in function.

When using Cisco Supervisor Desktop, an agent supervisor can use the barge-in function while in the Ready or Not Ready state.

Supervisor Desktop does not allow barge-in when the agent is:

- On hold
• On two calls
• On a conference call
• Already on another call
• Running Cisco Agent Desktop—Browser Edition (CAD-BE)

**Intercept**

When using the CTI OS Desktop, you can only use the **Intercept** button after barge-in. The supervisor can use the **Intercept** button to remove the agent from the call, leaving only the supervisor and the customer on the call.

**Note:** The **Intercept** button mentioned above refers to the button located on the CTI OS Desktop (**soft phone**), *not* the button on the **hard phone**.

When using Cisco Supervisor Desktop, an agent supervisor can intercept an agent's call without using barge-In.

Supervisor Desktop does not allow intercept when the agent is:

• On hold
• On two calls
• The Supervisor Desktop self is on another call
• An IP Phone agent
Routing Tasks for Multichannel Options

If you have installed multichannel features with Unified CCE, it is important that you understand how Unified ICM/CCE software routes contacts and requests made from the Unified EIM Server and the Unified WIM Server.

This chapter contains the following topics:

- Configuring Cisco Unified Intelligent Contact Management/Contact Center Enterprise Software for Multichannel Routing, page 31
- Configuring Multichannel Software, page 32

Configuring Cisco Unified Intelligent Contact Management/Contact Center Enterprise Software for Multichannel Routing

To route contact requests submitted from the World Wide Web or email, you must have configured:

- Media Routing Peripheral Gateway
- Media Routing Domains and Media Classes
- Multichannel agents
- Application instances
- Administration connections
- Multichannel skill groups
- Multichannel routing scripts
Configuring Multichannel Software

See Also

For information on configuring Unified CCE for multichannel routing, refer to the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted.

Configuring Multichannel Software

When your Unified ICM/CCE configuration is complete, you must configure your Unified ICM multichannel software and Cisco Media Blender.

The multichannel software you must configure includes:

• Cisco Unified Interaction Manager, which includes Unified EIM and Unified WIM
• Cisco Media Blender

See Also


Part 2: Performing Administrative Tasks with Cisco Unified Contact Center Enterprise

The following sections describe the configuration required for setting up Unified CCE agents and agent features. These sections also provide information on setting up voice and multichannel routing with Unified CCE.

**Note:** If you choose to upgrade Unified CM, you need to update the Java Telephony API (JTAPI) client on the Unified CM PG and then restart the PG. If you perform Unified CM maintenance that involves configuration changes only, the Unified CM PG does not require restart. Refer to the *Cisco Unified Contact Center Express Administration Guide* for detailed information about updating the JTAPI Client.
Administering Agents

This chapter explains the tasks you must be familiar with when setting up agents for your Unified CCE contact center.

This chapter contains the following topics:

- How to Administer Agents, page 35
- How to Configure Not Ready Reason Codes, page 39
- How to Configure Agent Features, page 40
- How to Configure Supervisor Features, page 45
- Using the Cisco Unified Contact Center Enterprise Agent Re-skilling Tool, page 45
- Configuring Network Transfer for IVRs, page 47

How to Administer Agents

This section provides detailed instructions about administering agents:

- How to Create Cisco Unified Contact Center Enterprise Voice-Only Agents (page 36)
- How to Delete Cisco Unified Contact Center Enterprise Voice-Only Agents (page 36)
- How to Create an Agent Supervisor (page 37)
- How to Delete an Agent Supervisor (page 38)
- How to Create Agent Teams (page 38)
- How to Delete Agent Teams (page 38)
How to Create Cisco Unified Contact Center Enterprise Voice-Only Agents

**Note:** You must ensure that you have already set up Agent Desk Settings before configuring agents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Use the Agent Explorer tool in the Cisco Unified ICM/CCE/CCH Configuration Manager (Configuration Manager) to create an Agent record. If you want to associate this agent with an existing Person record, select the **Select Person** button. | Creates an Agent record associated with the Person record.  
**Note:** **Important!** Do not change an agent's ID while the agent is logged into the CTI Toolkit Agent Desktop.  
Enter the agent information and select **Save** to save the record. See the online help for more information.   
**Note:**  
- Agent IDs can be up to nine digits long. The first digit in the ID must be 1 through 9. It cannot be 0. Also, this number cannot be the same as the extensions on the CCM cluster for this agent.  
- If you change the Agent ID (Peripheral ID), you must cycle the PG in order to populate the new agent ID and information in the CTI Toolkit IPCC Supervisor Desktop. |
| 2    | Select **Save**.                                                                                                                          | Creates the Agent record.  
If you did not use the **Select Person** button to associate the agent with an existing Person record, a new Person record is automatically created for the agent. |

**Note:** You can also add many agents at one time using the Bulk Configuration tool.

How to Delete Cisco Unified Contact Center Enterprise Voice-Only Agents

You logically delete agents using the Agent Explorer tool. Agents cannot be deleted from the Agent Explorer until they have been removed from any teams using the Agent Team List tool. If agents exist in script references, use the Script Reference tool to find any existing references, then use the Script Editor application to delete that script. Agents still exist in the deleted objects databases until permanently deleted.

**Note:** For scripting and reporting purposes, if the script is configured to send a call directly to an agent and that agent is permanently deleted, the call/script would fail. Also, you can run historical reports for permanently deleted agents.
### Purpose

**Step** | **Action** | **Purpose**
---|---|---
1 | Delete the Agent record.  Use the Agent Explorer tool in the Configuration Manager to delete the Agent record.  Highlight the agent and select **Delete**.  **Note:** If this was the last or only Agent record associated with the Person record for this agent, then the associated Person record is also deleted.  **Example:**  ICM Configuration Manager > Tools > Explorer Tools > Agent Explorer | Deletes the agent as well as the associated person.
2 | Purge the agent from the deleted objects.  Highlight the Agent table name in the Tables with Deleted Records window, then highlight the agent in the Deleted Records of the "Agent" Table window.  Select **Delete**.  **Example:**  ICM Configuration Manager > Tools > Miscellaneous Tools > Deleted Objects | Permanently deletes the agent from the database.

### How to Create an Agent Supervisor

You create an agent supervisor by simply modifying the Agent record in the Configuration Manager.

### Description

**Step** | **Action** | **Description**
---|---|---
1 | Select the Supervisor tab in the Agent Explorer tool application when creating or modifying an Agent record.  | Accesses an Agent record.
2 | Check the **Supervisor Agent** check box. Enter the Windows Domain name.  | Designates the agent as a supervisor.  Complete the remaining fields on this tab as described in the Configuration Manager online help.

**Note:** Important! You must perform the configuration listed above so the supervisor can use the Barge-In and Intercept features.
How to Delete an Agent Supervisor

You delete an agent supervisor by simply modifying the Agent record in the Configuration Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Supervisor tab in the Agent Explorer tool application when deleting an Agent record.</td>
<td>Accesses an Agent record.</td>
</tr>
<tr>
<td>2</td>
<td>Uncheck the <strong>Supervisor Agent</strong> check box.</td>
<td>Agent is no longer designated as a supervisor.</td>
</tr>
</tbody>
</table>

**Note:** If you want to delete the entire record, follow the guidelines for deleting an Agent record in the "How to Delete Cisco Unified Contact Center Enterprise Voice-Only Agents (page 36)" section.

How to Create Agent Teams

After adding agents with the Agent Explorer tool, you can create agent teams with the Agent Team List tool.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access the Agent Team List tool in the Configuration Manager.</td>
<td>Access the Agent Team List tool.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Team List</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Select <strong>Retrieve</strong>, and then select <strong>Add</strong> to add a new agent team.</td>
<td>Allows you to begin defining a new agent team. Complete the window, adding desired agents to the team.</td>
</tr>
<tr>
<td>3</td>
<td>Select the Members tab.</td>
<td>Allows you to select agents to add to the team.</td>
</tr>
<tr>
<td>4</td>
<td>Select the Supervisor tab.</td>
<td>Allows you to designate a supervisor for the team.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>With Unified CCE, assign both a primary and a secondary supervisor to each agent team.</td>
</tr>
</tbody>
</table>

How to Delete Agent Teams

You delete agent teams with the Agent Teams List tool. You cannot delete a team until you have removed the agent and supervisor from that team.
## How to Configure Not Ready Reason Codes

### Step 1
**Command or Action:** In the Configuration Manager, configure Not Ready reason codes.
**Example:**
```
ICM Configuration Manager > Tools > List Tools > Reason Code List
```
**Description:** Configure the Agent Not Ready reason codes in the Reason Code List tool.

**Note:** If you are using the CTI Toolkit Agent Desktop, make sure the reason codes match the codes on the desktop. Unified ICM reason codes display in the Agent Not Ready reports, but the agent actually selects the desktop code, so these codes must match to avoid confusion. Configure predefined Not Ready reason codes so their text displays in the reports.

### Step 2
**Command or Action:** In the Configuration Manager, enable the Agent event detail option.
**Example:**
```
ICM Configuration Manager > Tools > Explorer Tools > PG Explorer
```
**Description:** Open the PG Explorer tool, select the PG, and select the Cisco Unified CM peripheral. Then check the Agent event detail check box on the Agent Distribution tab to enable reporting on Not Ready reason codes.

### Step 3
**Command or Action:** Configure the Not Ready reason codes on the desktop.
**Description:**

### See Also
For information about configuring CTI OS Logout and Not Ready reason codes, refer to the *CTI OS System Manager’s Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.*
How to Configure Agent Features

This section describes how to perform the following tasks:

- Configure Unified CCE for Redirection on No Answer situations on IP IVR and Unified CVP
- Configure automatic wrap-up
- Configure supervisor assist and emergency alert situations

How to Configure Cisco Unified Contact Center Enterprise for Redirection on No Answer Situations on IP IVR

**Note: Important!** Unified CM is the Unified ICM Routing Client that ensures the call arrives at the right destination.

The recommended Redirection on No Answer situation configuration is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the Configuration Manager, configure Agent Desk Settings.  
*Example:*  
ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List | Allows you to define the following:  
- A Redirection on No Answer time  
- Redirection on No Answer dialed number  
(to access the Redirection on No Answer script defined in Step 3, below)  
*Note:* The Redirection on No Answer timer is not applicable if the **Auto answer** option is enabled since the Redirection on No Answer feature and Force Answer are mutually exclusive. If both are defined, Auto answer takes precedence over Redirection on No Answer. |
| 2    | In the Configuration Manager, set up the call type.  
*Example:*  
ICM Configuration Manager > Tools > List Tools > Call Type List | Set up the call type and associate it with the dialed number and the routing script. |
| 3    | Using the Script Editor, create a routing script to handle Redirection on No Answer situations. | Allows you to define routing logic used for situations when an assigned agent does not answer. |
Note:

- If you configure the Redirection on No Answer timer in the Unified ICM Agent Desk Settings, it is not necessary to configure the Unified CM Call Forward No Answer fields for the agent extensions in the Unified CM configuration. If you would like to configure them for cases when an agent is not logged in, set the Unified CM system service parameter for Unified CM Call Forward No Answer timer at least 3 seconds higher than the Unified ICM Redirection on No Answer timer on each of the Unified CM nodes.

- If you want to ensure that Redirection on No Answer calls adversely affect the service level, define the service level threshold to be less than the Redirection on No Answer timer at the call type and service.

How to Configure Cisco Unified Contact Center Enterprise for Redirection on No Answer Situations on Cisco Unified Customer Voice Portal

For Unified CCE systems in which Unified CVP is deployed, the Unified CM does not control Unified CVP and cannot send an unanswered call back to Unified CVP for re-queuing. You configure the Re-route on Redirection on No Answer feature to only make the agent state "Not Ready" when the agent does not answer a call; you can use the Unified CVP Target Requery feature to re-route the call. Refer to the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted for more details.

Note: Important! Unified CM does not control the queuing platform (Unified CVP); therefore, Unified CM cannot send the call back to Unified CVP for re-queuing.

Recommended configuration for Redirection on No Answer situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Configuration Manager, configure Agent Desk Setting</td>
<td>Allows you to define the following:</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>• A Redirection on No Answer time: Set this number less than the number set for the No Answer Timeout for the Target Requery that</td>
</tr>
<tr>
<td>Step</td>
<td>Command or Action</td>
<td>Purpose</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>you set in Unified CVP (causes agent to be made unavailable after the Redirection on No Answer timer expires, but will not invoke the Redirection on No Answer mechanism to re-route the call—see Step 3, below)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Redirection on No Answer dialed number (to access the Redirection on No Answer script): Leave this field blank</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The Redirection on No Answer timer is not applicable if Auto-answer is enabled since the Redirection on No Answer feature and Force Answer are mutually exclusive. If both are defined, Auto-answer takes precedence over Redirection on No Answer.</td>
</tr>
<tr>
<td>2</td>
<td>Using the Unified CVP VBAdmin tool, configure the Unified CVP ring-no-answer timeout value.</td>
<td>This step causes Unified CVP to issue a requery to the system software, if the assigned agent does not answer. In the VBAdmin tool, use the SetRNATimeout command to set the ring-no-answer timeout to a duration that is two seconds longer than the Redirection on No Answer time set in Step 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Set this timeout to under 30 seconds since the system software waits 30 seconds for Unified CVP to return a routing label and then fails, so Unified CVP needs to requery before this happens.</td>
</tr>
<tr>
<td>3</td>
<td>Using the Script Editor, account for requeries in the routing script to handle Redirection on No Answer situations. Use the Target Requery script feature.</td>
<td>Allows you to report on Redirection on No Answer information. This script enables Requery (enables the Requery check box) on the node in the script that selects and delivers the call to the first agent. Depending on the type of node used, the Requery mechanism selects a new target from the available agents or requires additional scripting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Refer to the Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise &amp; Hosted for information on how Requery works for the different nodes.</strong></td>
</tr>
</tbody>
</table>
|      |                  | **Note:** Do not create and schedule a new Routing script for Redirection on No Answer purposes in Unified CVP deployments. **Note:** **Important!** This script queues the call at the highest priority in the skill group(s) defined within the call variables. Otherwise, the call is
### Purpose

- no longer the first in queue, as it was when it was first assigned to the (unavailable) agent.

### Note:

- If you configure the Redirection on No Answer timer in the Unified ICM Agent Desk Settings, it is not necessary to configure the Unified CM Call Forward No Answer fields for the agent extensions in the Unified CM configuration. To configure them for cases when an agent is not logged in, set the Unified CM system service parameter for Unified CM Call Forward No Answer timer at least 3 seconds higher than the Unified ICM Redirection on No Answer timer on each of the Unified CM nodes.

- To ensure that Redirection on No Answer calls adversely affect the service level, define the service level threshold to be less than the Redirection on No Answer timer at the call type and service.

### How to Configure Automatic Wrap-Up

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | Configure Agent Desk Settings to require automatic wrap-up. | Allows you to force agents into Wrap-up mode when they are finished with inbound or outbound calls. Use these two fields to enable automatic wrap-up:  
- Work mode on Incoming  
- Work mode on outgoing  
Choose either Required or Required with wrap-up data to indicate automatic wrap-up. Also, enter the time, in seconds, allocated to an agent to wrap-up a call. |
| 2    | Configure Agent Desk Settings to require appropriate reason codes. | Allows you to determine if and when agents are required to enter a Reason Code when they log out or enter a Not Ready state. |

### How to Configure Supervisor Assist and Emergency Alert Situations

The recommended supervisor assist and emergency alert situation configuration is detailed in the table below:
### How to Configure Agent Features

**How to Configure Agent Features**

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the Configuration Manager, configure Agent Desk Settings.  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List | Allows you to define the following:  
• Assist call method  
• Emergency alert method |
| 2    | In the Configuration Manager, set up the call type  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Call Type List | Set up the call type and associate it with the dialed number and the routing script. |
| 3    | In the Configuration Manager, configure Dialed Number for supervisor  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Dialed Number/Script Selector List | Allows you to define the following:  
• Dialed number string  
• Call type |
| 4    | In the Configuration Manager, configure Agent Team  
**Example:**  
ICM Configuration Manager > Tools > List Tools > Agent Team List | Allows you to define the Supervisor script dialed number option. |
| 5    | Using the Script Editor, create a routing script to associate the dialed number.  
Use the Agent to Agent node to route the call to the primary supervisor by editing the formula with the call. preferredagentid. In addition, in case this routing fails, set up a route to the skill group where the secondary supervisors are located.  
**Note:** Refer to the *CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted* for detailed information. | Allows you to report on blind conference and consultative call information. This script associates the supervisor's dialed number with the script using the Script Editor's Call Type Manager window. |

### See Also

For information about agent desk settings, agent teams, and dialed numbers, refer to the *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted* and the Configuration Manager online help.

For information about reason codes, refer to the *CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*. 
How to Configure Supervisor Features

This section explains how to configure the supervisor logged-in state for CAD.

How to Configure Supervisor Logged-in State for CAD

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the Configuration Manager, configure Agent Desk Settings for the CAD supervisor. **Example:**  
  ICM Configuration Manager > Tools > List  
  Tools > Agent Desk Settings List | Create separate desk settings for the CAD supervisor. |
| 2    | Leave the **Logout non-activity time** option blank. | Leaving this option blank keeps a supervisor logged into Cisco Agent Desktop.  
  A CAD supervisor uses Cisco Supervisor Desktop to view agent activity, silently monitor, record agent calls, send Team Performance Messages, and chat with agents and other supervisors. A supervisor can only barge in, intercept, or view skill statistics if Cisco Agent Desktop is running on the supervisor’s computer. |

**See Also**

For information about Agent Desk Settings, refer to the *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted* and the Configuration Manager online help.

For information about barge-in and intercept, refer to the *CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

Using the Cisco Unified Contact Center Enterprise Agent Re-skilling Tool

Accessing the Unified CCE Agent Re-skilling Tool

Access to the Agent Re-skilling Tool is limited to individuals with supervisor privileges.

**Note:** This tool is accessible using Unified SCCE or within Unified CCE.
To access the Agent Re-skilling Tool using your agent name:

1. In your browser's address bar, enter:

   https://<agent_reskilling_server_ip_or_dns>/reskill

   Your administrator must provide you with this address.

2. Press Enter. The Login page displays.

3. Enter your supervisor username and password.

   **Note:** As of version 7.2, in a *Unified SCCE* system, the login name to the Agent Re-skilling tool is **NOT case sensitive**. In a *Unified CCE* system, the login name to the Agent Re-skilling tool **may or may not be case sensitive**. This is determined by the "Login case sensitive" value in the System Information screen under Miscellaneous Tools in the Configuration Manager.

4. Select Login.

In certain deployments, you have the option of logging into the Agent Re-skilling Tool using your numeric agent ID. To log in using your agent ID:

1. In your browser's address bar, enter: https://

   <agent_reskilling_server_ip_or_dns>/reskill

   Your administrator must provide you with this address.

2. Press Enter. The Login page displays.

3. Select the Login By Agent ID link.

   **Note:** If this link does not appear on the Login Page you can only log in using your login name.

4. Enter your numeric agent ID and password.

5. Select the correct peripheral for your agent ID. Consult your administrator if you are not sure of your correct peripheral.

6. Select Login.

For security purposes, log out when you are finished using the Agent Re-skilling Tool. Select the Log Out link at the top-right of the page. This action returns you to the Login page. Sessions also time-out automatically after 30 minutes of inactivity. If your session has ended due to inactivity, you are prompted to login again to resume using the tool.

**See Also**

For detailed information about using the Unified CCE Agent Re-skilling tool, refer to the online help.
Configuring Network Transfer for IVRs

This section provides instructions on:

- How to Configure Network Transfer from an IP Phone (page 47)
- How to Configure Network Transfer from a CTI OS Desktop (page 47)

How to Configure Network Transfer from an IP Phone

To configure network transfer from an IP Phone, complete the following steps:

1. Define a CTI Route Point, for example "9999," in the Unified CM. Associate it with the JTAPI User that is connected to IPCC PIM in the system software.

2. In the Administration Client or Administration & Data Server, define a Dialed Number for IPCC PIM and a call type for that dialed number. This call type can then be associated with a Unified ICM script; for example, "NetXfer2."

   **Note:** Do not define the labels of agents for the Unified CM PG. Instead, define the labels for the VRU PIM so that the route result is returned to VRU instead of a Unified CM PG. If you do define the agent labels for the Unified CM PG, the Router returns the route result to the VRU PIM, if "Network Transfer Preferred" is enabled on the Unified CM PG and VRU PIM and returns the route result to the Unified CM PG if "Network Transfer Preferred" is disabled on the Unified CM PG and VRU PIM.

3. When the call is delivered to Agent 1 using the Unified ICM Script "NetXfer1," the agent can dial the number 9999 to send the call to another script, "NetXfer2."

How to Configure Network Transfer from a CTI OS Desktop

To configure network transfer from a CTI OS Desktop, complete the following steps:

1. Define a "Dialed Number Plan" in the system software. The routing client is the IPCC PIM and the dialed number is the one defined before for the IPCC PIM (that is, IPCC_PIM.9999).

2. Set the Post Route to **Yes** and the Plan to **International**.

3. In the Agent Desk Settings, check all the **Outbound access** check boxes.
Chapter 5

Routing Voice Calls with Cisco Unified Contact Center Enterprise

This chapter contains the following topics:

- How to Set Up Cisco Unified Contact Center Enterprise Voice Routing, page 49
- How to Route to a Target Device with Cisco Unified Contact Center Enterprise, page 50

How to Set Up Cisco Unified Contact Center Enterprise Voice Routing

How to Configure a Device Target with Cisco Unified Contact Center Enterprise

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add/configure IP Phone on Unified CM.</td>
<td>Creates device.</td>
</tr>
<tr>
<td>2</td>
<td>Create/configure a Device Target on the system software, being sure to enter the Dialed Number associated with the IP Phone. Use this string when entering the dialed number: /devtype ciscophone/dn 9510.</td>
<td>Ensures that Unified ICM can send this string to the Unified CM to initialize the device.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Targets &gt; Device Target &gt; Device Target Explorer</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Associate the device in Unified CM with the selected Global User.</td>
<td>Maps the user and CTI Route Point.</td>
</tr>
</tbody>
</table>
Setting Up Duplicate Extensions in Multi-Site Cisco Unified Contact Center Enterprise Installations

You can use duplicate extensions in different sites in a multi-site Unified CCE configuration. To accomplish this, you must associate the device targets with the appropriate peripheral using the /PID configuration parameter. This ensures that the device target is tied to the peripheral and is not recognized by other peripherals.

To associate a device target with a peripheral:

- Using the Device Target Explorer, add or modify single device target entries. (Use the Device Target Bulk (Insert) tool when adding a new device.)

- Set the Configuration Parameter field to /PID <xxxx>, where <xxxx> is the four-digit Peripheral ID (that is, /PID 5000). When you save this change, it takes effect immediately. You do not need to cycle the Unified CM PG Node services for this to take effect.

How to Route to a Target Device with Cisco Unified Contact Center Enterprise

The following procedures outline the steps to follow each time you want to route to a new device target in Unified CCE.

On Unified CM

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a CTI Route Point on the Unified CM.</td>
<td>Configures the Unified CM to make a route request to the system software when the Route Point is dialed.</td>
</tr>
<tr>
<td>2</td>
<td>Associate the CTI Route Point with the PG User.</td>
<td>Makes the Route Point visible to the system software.</td>
</tr>
</tbody>
</table>

Using the Configuration Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new Dialed Number using the Configuration Manager.</td>
<td>Defines a new entry point for call routing.</td>
</tr>
<tr>
<td>2</td>
<td>Add a new Call Type using the Configuration Manager.</td>
<td>Allows you to categorize calls and route them appropriately.</td>
</tr>
<tr>
<td>3</td>
<td>Associate the Dialed Number with the Unified ICM Call Type.</td>
<td>Allows you to map the Dialed number to a routing script.</td>
</tr>
<tr>
<td>4</td>
<td>Create a new routing script using the Script Editor.</td>
<td>Routes the call to the entry point.</td>
</tr>
<tr>
<td>5</td>
<td>Associate the Call Type with the routing script.</td>
<td>Associates the Call Type with the routing script.</td>
</tr>
</tbody>
</table>
Note:

- In a Unified CM cluster, be aware that two routing clients must not share the same CTI Route Point. Each routing client must use distinct CTI Route Points in a Unified CM cluster.

- When configuring calling party transformation mask for translation pattern in Unified CM, the application will have additional connections/disconnections. Therefore, it is recommended not to have translation pattern mask for calling party for the IPCC components to function properly.

How to Enable Sub-skill Peripherals and Skill Groups

Only base skill groups are supported for Unified CCE configurations. A default is set at the peripheral level, ensuring that any new skill group created is base-only.

See Also

For more information about creating routing scripts, refer to the *Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted* and the Script Editor online help.

For more information about configuring Unified CCE, refer to the *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted*. 

How to Route to a Target Device with Cisco Unified Contact Center Enterprise
Chapter 6

The Dialed Number Plan

Note: The Dialed Number Plan is only applicable to the Voice media.

This chapter contains the following topics:

• About the Dialed Number Plan, page 53
• About Dialed Number Plan Values, page 55
• How to Configure the Dialed Number Plan, page 58

About the Dialed Number Plan

The Dialed Number Plan allows you to manage and track agent-initiated calls.

The Dialed Number Plan only applies to calls initiated by the agent on their soft phone and not on their hard phone. Calls made on the hard phone are not subject to the permission, interpretation, translation, posting routing, and so on, specified in the Dialed Number Plan.

Understanding the Dialed Number Plan

The Dialed Number Plan consists of a number of entries intended to accommodate the different types of calls agents might make. Each entry contains a wildcard string that is used to match a number that an agent might dial. Each digit of the string is processed until a matching dial plan entry is found. When found, the selected trunk group or resource is used to complete the call.

Each entry contains additional information indicating how to handle the calls matching that wildcard string.

For example, dialing a 9 to receive an outside line on a PBX or ACD is specified in the dial plan. All patterns that reference network trunks might begin with a '9' digit. Subsequent digits might be '1' for long distance patterns, '0' for operator assisted or international calls, '2' through '9' to specify an area code. The dial plan allows a customer to have multiple phone carrier trunks
terminated at the PBX or ACD for different outbound call types. A customer might choose MCI as the long distance carrier while AT&T is the international carrier, and Bell Atlantic is the local carrier. The dial plan configuration is used to determine which carrier to use based on the patterns defined within the dial plan.

**Note:** Do not confuse the Dialed Number Plan Bulk Insert tool with the Dialed Number Bulk Insert tool.

You use the Dialed Number Plan to:

- Ensure agent-initiated calls are routed by a Unified ICM routing script
- Set up basic dialing substitutions

### Using the Dialed Number Plan to Ensure Cisco Unified Intelligent Contact Management Routing of Agent Calls

The most common and powerful use of the Dialed Number Plan is to ensure that agent-initiated calls are routed through the system software. In this case, you must specify that you want to request a PostRoute for the call and specify a dialed number associated with a routing script designed to handle the type of agent call.

Use this method of configuring the Dialed Number Plan for:

- Agent-to-agent transfers
- Agent-to-agent calling
- Agent-initiated outbound calls

### Using the Dialed Number Plan to Set Up Basic Dialing Substitutions

You can also use the Dialed Number Plan to specify basic dialing substitutions. In this scenario, you identify a wildcard pattern to match the number dialed by an agent. However, you do not request a Post Route and the call is not matched to a Dialed Number, and thus not routed by the system software. Instead, you enter the string you want to be dialed in the Dial String field. That string is used to place the agent's call.

Using the Dialed Number Plan in this way is most useful for setting up such things as:

- Speed Dial
- Using alphanumeric characters to dial from a soft phone
About Dialed Number Plan Values

Each field on the Dialed Number Plan dialog is defined in the Configuration Manager online help. This section provides additional information about these fields and how you can use them to set up agent dialing for your contact center.

The window below illustrates a Dialed Number Plan entry that specifies Unified ICM routing for the agent call:

Figure 1: Dialed Number Plan Entry Specifying Unified ICM Routing for the Agent Call

Wildcard Pattern

The wildcard pattern you enter can contain letters, digits, and number signs (#). It can also include the following wildcard characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Represents any single alphanumeric character.</td>
</tr>
<tr>
<td>!</td>
<td>Represents any string of character and can appear only at the end of a pattern.</td>
</tr>
</tbody>
</table>
Routing Client

The Routing Client field lets you specify the routing client for the agent call. In Unified CCE configurations, set this field to identify the Unified CM PG.

Post Route

Use the Post Route field to specify whether this type of agent call will be sent to a routing script. If you set Post Route to Yes, you must also enter a Dialed Number that is associated with a routing script designed to handle the type of agent call.

Dialed Number

Use the Dialed Number field if you have set the Post Route field to Yes, indicating that you want a Unified ICM routing script to handle this agent call.

Dial String

Use the Dial String field only when you set the Post Route field to No, indicating that you want to use this entry for dialing substitutions. This field cannot be used when PostRoute is selected to send the call to a Unified ICM routing script.

The Dial String field can contain wildcard characters used to translate the dialed number string provided by the agent to the dial string that will be delivered to the switching platform. The following table describes the wildcard characters that might appear in the DialString field.

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Matches any group of characters</td>
</tr>
<tr>
<td>?</td>
<td>Matches any single character</td>
</tr>
<tr>
<td>X or x</td>
<td>Excludes the character in the agent supplied dialed number string at the position identified from the offset as defined from the beginning of the DialedNumberPlan DialString field</td>
</tr>
</tbody>
</table>

The following table provides examples of the translation of a DialedNumber string specified by an agent to a resultant DialString as defined by the DialString entry of the matching DialedNumberPlan entry.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumber Plan Dial String</th>
<th>Dial string result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5133</td>
<td>6100</td>
<td>6100</td>
<td>Direct substitution.</td>
</tr>
<tr>
<td>5133</td>
<td>6X???</td>
<td>6133</td>
<td>Partial replacement.</td>
</tr>
<tr>
<td>5133</td>
<td>!</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>9275!</td>
<td>92755133</td>
<td>Prefix Addition.</td>
</tr>
<tr>
<td>5133</td>
<td>62XX??</td>
<td>6233</td>
<td>First 2 char substitution.</td>
</tr>
</tbody>
</table>
Using the Dial String for Speed Dialing

You can configure Static Dial String translations to provide speed dial capabilities. Here, you enter the abbreviated string an agent would dial in the wildcard pattern. You enter the actual target number in the Dial String of the entry.

When a dialed number (provided by an agent) matches the wildcard pattern of the Dialed Number Plan entry, the Dial String configured entry is sent in place of the agent supplied Dialed Number string.

The following table provides an example of a speed dial configuration.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumber Plan Dial String</th>
<th>Dial string result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5133</td>
<td>????</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>?XXX000</td>
<td>5000</td>
<td>Retain first character; substitute the remaining characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>????200</td>
<td>2755200</td>
<td>Replace last three characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>!220</td>
<td>2755100220</td>
<td>Suffix addition.</td>
</tr>
</tbody>
</table>

Using the Dial String for Alphanumeric Substitutions

You can use the Dialed Number Plan to allow agents to specify an alphanumeric string when dialing. For instance, an agent might dial "SALES" when calling the sales department rather than a numeric value that might be harder to remember.

To configure an alphanumeric substitution, configure the alphanumeric dial string as the wildcard pattern and the target number as the Dial String of the DialedNumberPlan entry. When a dialed number provided by an agent matches the wildcard pattern of the Dialed Number Plan entry, the configured Dial String is sent in place of the agent supplied string.

Wildcard characters can be combined with this feature to allow Alpha prefixes to be added to numbers to identify the location of the number. Examples are shown in the following table:

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumberPlan Dial String</th>
<th>Resultant Dial String</th>
</tr>
</thead>
<tbody>
<tr>
<td>SALES</td>
<td>919782755100</td>
<td>919782755133</td>
</tr>
<tr>
<td>BOS5133</td>
<td>9782755133</td>
<td>9782755133</td>
</tr>
<tr>
<td>FL14Office1433</td>
<td>5133</td>
<td>5133</td>
</tr>
</tbody>
</table>

Dial Number Type Plan

The Dial Number Type Plan lets you specify the type of call that will be placed. These include:
### Dialed Number Plan

<table>
<thead>
<tr>
<th>Dialed Number Plan</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td>Allows agents to place calls classified as international calls.</td>
</tr>
<tr>
<td>National</td>
<td>Allows agents to place calls classified as national long distance calls.</td>
</tr>
<tr>
<td>Local</td>
<td>Allows agents to place calls classified as national local calls.</td>
</tr>
<tr>
<td>Operator Assisted</td>
<td>Allows agents to place calls classified as operator assisted calls.</td>
</tr>
<tr>
<td>PBX</td>
<td>Allows agents to place calls to agents on the same peripheral.</td>
</tr>
</tbody>
</table>

The options for this field map exactly with the options on the Agent Desk Settings List window. The system software checks the Agent Desk Settings for the agent placing the outbound call. Agent Desk Settings define which types of calls agents are permitted to make. If the Agent Desk Settings for an agent prevent him or her from placing a particular type of call (for instance, international), the call is not placed.

## How to Configure the Dialed Number Plan

### How to Use the Dialed Number Plan to Ensure Cisco Unified Intelligent Contact Management Routing of Agent Calls

Follow these steps to configure a Dialed Number Plan entry to route an agent call through the system software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a routing script to handle each type of agent-initiated call using the Script Editor.</td>
<td>Ensures agent-initiated calls are routed appropriately by the system software. The script can target agent, services, or skill groups using Unified ICM script nodes. When a target is chosen, the associated label is sent back to the requesting peripheral. The label value is substituted for the dial string specified by the agent and sent to the switching platform to place the outbound call.</td>
</tr>
</tbody>
</table>
| 2    | In the Configuration Manager, set up the call type. **Example:**  

ICM Configuration Manager > Tools > List Tools > Call Type List | Set up the call type and associate it with the dialed number to target to routing scripts.  
**Note:** You can also use a pre-existing call type and script. |
| 3    | Insert an entry in the Dialed Number Plan dialog. Using the fields in this window, make sure to: | Matches the agent's dialed string to a Dialed Number. This ensures the agent's... |
### How to Configure the Dialed Number Plan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>•</td>
<td>Indicate the appropriate wildcard character.</td>
<td>call will be routed by a Unified ICM routing script.</td>
</tr>
<tr>
<td>•</td>
<td>Set the Post Route text box to <strong>Yes</strong>.</td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>Select a valid Dialed Number associated with the routing script used to route the agent call.</td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>Set the Dial Number Type Plan to indicate the type of call.</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICM Configuration Manager &gt; Tools &gt; Bulk Configuration &gt; Insert &gt; Dialed Number Plan Bulk Insert</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4 Ensure Agent Desk Settings are set to identify the types of calls agents can place.

**Example:**

ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List

Ensures that agents are allowed to or restricted from placing different types of outbound calls.

---

### How to Use the Dialed Number Plan to Set Up Basic Dialing Substitutions for Agent Calling

Follow these steps to configure a Dialed Number Plan entry to route an agent call through the system software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert an entry in the Dialed Number Plan dialog. Using the fields in this window, make sure to:</td>
<td>Matches the agent's dialed string to the Dial String indicated in the entry. This Dial String is used to place the call (the call will not be routed by the system software).</td>
</tr>
<tr>
<td>•</td>
<td>Indicate the appropriate wildcard character.</td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>Set the PostRoute field to <strong>No</strong>.</td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>Identify a valid Dial String used to place the call.</td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>Set the Dial Number Type Plan to indicate the type of call.</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICM Configuration Manager &gt; Tools &gt; Bulk Configuration &gt; Insert &gt; Dialed Number Plan Bulk Insert</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2 Ensure Agent Desk Settings are set to identify the types of calls agents can place.

Ensures that agents make only the types of outbound calls they are permitted to make.
How to Configure the Dialed Number Plan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td></td>
</tr>
</tbody>
</table>

See Also

For more information on Unified ICM Routing Scripts, refer to the *Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

For more information about Agent Desk Settings, see the "About Agent Desk Settings (page 11)" section.
Index

/PID....50
administering agents....9
agent desk settings
    about....11
    reason codes....24
Wrap-up....24
Agent desk settings
    Idle reason required....24
    Logout reason required....24
    Work mode....24
agent desktop features, configuring....23
Agent Re-skilling tool
    about....13
    accessing....45
agents
    about....9
    about supervisors....11
    about teams....11
    administering....9
changing skill group designations....13
configuring Not Ready reason codes....39
creating....35
creating voice-only....36
deleting voice-only....36
entering Wrap-up mode....23
multichannel....9
reason codes....24
teams, creating....38
teams, deleting....38
teams, multichannel....12
voice-only....9, 10
agent supervisor
    creating....37
deleting....38
agent teams
    about....11
    creating....38
deleting....38
agent types
    multichannel....9
    voice-only....9
agent wrap-up....23
alphanumeric substitutions, configuring....57
alpha prefixes, adding to numbers....57
Assist call method, configuring....43
automatic wrap-up
    configuring....43
Barge-in option....28
base skill groups
    about....19
    migrating from sub-skill groups....19
CAD
    configuring supervisor logged-in state....45
    configuring Work Mode on Incoming option....25
    configuring Work Mode on Outgoing option....25
    predefined reason codes....25
Call forward on Redirection on No Answer....27
Call forward on Ring No Answer
    configuring IPCC on IP IVR....40
    configuring Unified CCE on Unified CVP....41
calls, single-line vs. multi-line behavior....20
call types
    about....18
    identification....57
Cisco Media Blender....32
classifying call types....57
ConfigLimit tool, using....13
Configuration Manager, using....50
configuration parameters....50
configuring
agent features....40
agent features with Agent Desk Settings List tool....23
agent teams....38
alphanumeric substitutions....57
Assist call and Emergency alert methods....43
automatic wrap-up....43
CAD supervisor logged-in state....45
device target with IPCC Enterprise....49
multichannel routing....31
multichannel software, about....32
network transfer from a CTI OS Agent Desktop....47
network transfer from an IP phone....47
Not Ready reason codes....39
routing, about....17
speed dialing....57
Static Dial String translations....57
supervisor features....28
Work Mode on Incoming option for CAD....25
Work Mode on Incoming option for CTI OS Agent Desktop....24
Work Mode on Outgoing option for CAD....25
creating
agents....35
agent supervisor....37
agent teams....38
voice-only agents....36
CTI OS Agent Desktop
configuring network transfer....47
configuring Work Mode on Incoming option....24
CTI OS features, configuring....23
Database
Agent record....10
Person record....10
records for IPCC Enterprise agents using multichannel software....11
deleting
agent supervisor....38
agent teams....38
voice-only agents....36
desk settings, agent....23
desktop features, configuring....23
device targets
about....18
configuring with IPCC Enterprise....49
routing to a new....50
Dialed Number Plan
about....53
alphanumeric substitutions....54
configuring....54
dialed number....54
Dialed Number field....56
dial number type plan....57
dial string....57
Dial String field....56
ensuring routing of agent calls....58
Post Route....54
Post Route field....56
routiing agent-initiated calls....54
Routing Client field....56
setting up basic dialing substitutions for agent calling....59
specifying basic dialing substitutions....54
speed dialing....57
values....55
Wildcard pattern....55
dialed numbers....17
dialing substitutions, Dialed Number Plan....54
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>dial string, using for alphanumeric substitutions</td>
<td>57</td>
</tr>
<tr>
<td>duplicate extensions</td>
<td>50</td>
</tr>
<tr>
<td>E-Mail Interaction Manager (Unified EIM)</td>
<td>32</td>
</tr>
<tr>
<td>emergency alert method, configuring</td>
<td>43</td>
</tr>
<tr>
<td>emergency calls</td>
<td>28</td>
</tr>
<tr>
<td>enabling sub-skill peripherals and skill groups</td>
<td>51</td>
</tr>
<tr>
<td>Intercept option</td>
<td>29</td>
</tr>
<tr>
<td>IPCC Enterprise Web Administration Tool, about</td>
<td>1</td>
</tr>
<tr>
<td>IVRs, configuring network transfer</td>
<td>47</td>
</tr>
<tr>
<td>labels, about</td>
<td>19</td>
</tr>
<tr>
<td>limit, skill groups</td>
<td>13</td>
</tr>
<tr>
<td>Media Blender</td>
<td>32</td>
</tr>
<tr>
<td>migrating from sub-skill groups to base skill groups</td>
<td>19</td>
</tr>
<tr>
<td>modes, Wrap-up</td>
<td>23</td>
</tr>
<tr>
<td>multichannel agent database records</td>
<td>11</td>
</tr>
<tr>
<td>multichannel agents</td>
<td>9</td>
</tr>
<tr>
<td>multichannel routing, about configuring</td>
<td>31</td>
</tr>
<tr>
<td>multichannel software</td>
<td></td>
</tr>
<tr>
<td>Cisco Media Blender</td>
<td>32</td>
</tr>
<tr>
<td>Cisco Unified E-Mail Interaction Manager</td>
<td>32</td>
</tr>
<tr>
<td>Cisco Unified Web Interaction Manager</td>
<td>32</td>
</tr>
<tr>
<td>configuring</td>
<td>32</td>
</tr>
<tr>
<td>database records for IPCC Enterprise agents</td>
<td>11</td>
</tr>
<tr>
<td>multi-site installations, duplicate extensions</td>
<td>50</td>
</tr>
<tr>
<td>network transfer</td>
<td></td>
</tr>
<tr>
<td>configuring from a CTI OS Agent Desktop</td>
<td>47</td>
</tr>
<tr>
<td>configuring from an IP Phone</td>
<td>47</td>
</tr>
<tr>
<td>for IVRs, about</td>
<td>15</td>
</tr>
<tr>
<td>performing administrative tasks</td>
<td>35</td>
</tr>
<tr>
<td>Person database record</td>
<td>10</td>
</tr>
<tr>
<td>predefined reason codes</td>
<td>25</td>
</tr>
<tr>
<td>queue requests</td>
<td>16</td>
</tr>
<tr>
<td>reason codes</td>
<td></td>
</tr>
<tr>
<td>about</td>
<td>24</td>
</tr>
<tr>
<td>configuring</td>
<td>39</td>
</tr>
<tr>
<td>predefined</td>
<td>25</td>
</tr>
<tr>
<td>Wrap-Up</td>
<td>24</td>
</tr>
<tr>
<td>Reason codes</td>
<td></td>
</tr>
<tr>
<td>idle reason required</td>
<td>24</td>
</tr>
<tr>
<td>logout reason required</td>
<td>24</td>
</tr>
<tr>
<td>Redirection on No Answer</td>
<td></td>
</tr>
<tr>
<td>about</td>
<td>27</td>
</tr>
<tr>
<td>configuring IPCC on IP IVR</td>
<td>40</td>
</tr>
<tr>
<td>configuring Unified CCE on Unified CVP</td>
<td>41</td>
</tr>
<tr>
<td>route requests</td>
<td>16</td>
</tr>
<tr>
<td>routes, about</td>
<td>18</td>
</tr>
<tr>
<td>routing</td>
<td></td>
</tr>
<tr>
<td>about IPCC Enterprise</td>
<td>15</td>
</tr>
<tr>
<td>agent calls using Dialed Number Plan</td>
<td>58</td>
</tr>
<tr>
<td>agent calls with the Dialed Number Plan</td>
<td>54</td>
</tr>
<tr>
<td>and queuing requests</td>
<td>16</td>
</tr>
<tr>
<td>call to the VRU</td>
<td>17</td>
</tr>
<tr>
<td>call types</td>
<td>18</td>
</tr>
<tr>
<td>configuration, about</td>
<td>17</td>
</tr>
<tr>
<td>configuring for multichannel</td>
<td>31</td>
</tr>
<tr>
<td>device targets</td>
<td>18</td>
</tr>
<tr>
<td>dialed numbers</td>
<td>17</td>
</tr>
<tr>
<td>labels</td>
<td>19</td>
</tr>
<tr>
<td>multichannel requests, about</td>
<td>31</td>
</tr>
<tr>
<td>operations, about</td>
<td>15</td>
</tr>
<tr>
<td>scripts, about</td>
<td>20</td>
</tr>
<tr>
<td>services</td>
<td>19</td>
</tr>
<tr>
<td>skill groups</td>
<td>19</td>
</tr>
<tr>
<td>to a target device</td>
<td>50</td>
</tr>
<tr>
<td>to the VRU with IPCC Enterprise</td>
<td>16</td>
</tr>
<tr>
<td>voice calls</td>
<td>49</td>
</tr>
<tr>
<td>VRU</td>
<td>16</td>
</tr>
<tr>
<td>Routing Client, about</td>
<td>15</td>
</tr>
<tr>
<td>scripts, routing, about</td>
<td>20</td>
</tr>
<tr>
<td>services</td>
<td>19</td>
</tr>
</tbody>
</table>
setting up basic dialing substitutions for agent calling...59

skill groups
  about....19
  base....19
  changing agent designation....13
  migrating from sub-skills to base skills....19
  sub....19

skill groups, limit....13

speed
dial, configuring....57
dialing, Dialed Number Plan....57

speed dialing, configuring....57

static dial string translations....57

sub-skill groups....19
  migrating to base skill groups....19

supervisor
  assist calls....28, 43
  creating agent....37
  deleting agent....38
  using Barge-In option....28
  using Intercept option....29

supervisor features
  configuring, about....28
  configuring, how to....45
  monitoring agent team members....28

supervisors
  about....11
  assigning primary and secondary....11
  required information when creating....12
  using the Agent Re-skilling Tool....13

target devices....50
tasks, routing for multichannel options....31

teams
  about agent....11
  creating agent....38